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BAB II 

LANDASAN TEORI 

2.1 Media Pembelajaran 

 Media pembelajaran secara umum adalah alat bantu proses belajar 

mengajar. Segala sesuatu yang dapat dipergunakan untuk merangsang pikiran, 

perasaan, perhatian, dan kemampuan atau keterampilan pembelajar sehingga 

dapat mendorng terjadinya proses belajar. Batasan ini cukup luas dan mendalam 

mencakup pengertian sumber, lingkungan, manusia dan metode yang di 

manfaatkan untuk tuyjuan pembelajarn/pelatihan. 

 Menurut Sudjana (2006) bahwa. “salah satu kualifikasi yang harus 

dipenuhi oleh seseorang guru yaitu memilih dan menggunakan metode-metode 

belajar”.  Penggunaan metode dalam pembelajaran perlu diperhatikan 

kesesuaiannya dengan faktor-faktor yang mempengaruhi penggunaanya. 

Ada beberapa tujuan menggunakan media pembelajaran, di antranya yaitu : 

- mempermudah proses belajar-mengajar 

- meningkatkan efisiensi belajar-mengajar 

- menjaga relevansi dengan tujuan belajar 

- membantu konsentrasi mahasiswa 

- menurut Gagne : “Komponen sumber belajar yang dapat merangsang 

siswa untuk belajar” 

- menurut Briggs : “Wahana fisik yang mengandung materi 

instruksional” 
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- menurut Schramm : “Teknologi pembawa informasi atau pesan 

instruksional” 

- menurut Y. Miarso : “segala sesuatu yang dapat merangsang proses 

belajar siswa” 

Tidak diragukan lagi bahwa semua media itu perlu dalam pembelajaran. 

dalam memilih media pembelajaran, perlu disesuaikan dengan kebutuhan, situasi 

dan kondisi masing-masing. Dengan perkataan lain, media yang terbaik adalah 

media yang ada. Terserah kepada bagaimana ia dapat mengembangkanya secra 

tepat dilihat dari isi, penjelasan pesan karakteristik siswa untuk menentukan 

media pembelajran tersebut. 

 

2.2 Konsep Dasar Permulaan Menulis 

2.2.1  Definisi Menulis Permulaan 

 Menulis merupakan kegiatan komunikasi verbal yang berisi penyampaian 

pesan dengan menggunakan tulisan sebagai mediumnya.Pesan yang dimaksud di 

sini adalah isi atau muatan yang terkandung dalam tulisan, sedangkan tulisan pada 

dasarnya adalah rangkaian huruf yang bermakna dengan segala kelengkapan 

lambang tulisan seperti ejaan dan pungtuasi.Dengan demikian, menulis 

merupakan salah satu bentuk penggunaan bahasa, disebut keterampilan berbahasa, 

yang melibatkan empat unsur, yakni penulis sebagai penyampai pesan, pesan atau 

isi tulisan, saluran atau medium tulisan, dan pembaca sebagai penerima pesan 

(Yunus, 2002:13). 
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Sedangkan menurut Kamus Besar Bahasa Indonesia, menulis adalah 

melahirkan pikiran atau gagasan dengan tulisan. Dari pengertian menulis tersebut 

dapat disimpulkan bahwa menulis adalah proses mengungkapkan gagasan, pikiran 

dan perasaan kedalam bentuk tulisan. 

Menulis permulaan (beginning writing) adalah cara merealisasikan simbol-

simbol bunyi menjadi huruf-huruf yang dapat dikenali secara konkrit sesuai 

dengan tata cara menulis yang baik. Menulis permulaan merupakan tahapan 

proses belajar menulis bagi siswa sekolah dasar kelas awal. 

 

2.2.2 Tujuan Menulis Permulaan 

Dalam menulis permulaan, tujuannya adalah agar siswa dapat menulis 

kata-kata dan kalimat sederhana dengan tepat.Pada menulis permulaan siswa 

diharapkan untuk dapat memproduksi tulisan yang dapat dimulai dengan tulisan 

eja. Contoh tulisan e,d,f,k,j,dan dapat berupa suku kata seperti su-ka, ma-ta, ha-

rus, lu-ka serta dalam bentuk kalimat sederhana. 

Seperti halnya membaca permulaan, menulis permulaan juga dapat 

menggunakan metode-metode seperti metode abjad, metode suku kata, metode 

global dan metode SAS. Menulis permulaan (dengan huruf kecil) di kelas 1SD 

tujuannya adalah agar siswa memahami cara menulis permulaan dengan ejaan 

yang benar dan mengkomunikasikan ide/pesan secara tertulis, materi pelajaran 

menulis permulaan dikelas 1SD disajikan secara bertahap dengan menggunakan 

pendekatan huruf, suku kata, kata-kata atau kalimat. Menulis permulaan (dengan 

huruf besar pada awal kalimat) di kelas II tujuannya yaitu agar siswa memahami 
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cara menulis permulaan dengan ejaan yang benar dan mengkomunikasikan ide 

/pesan secara tertulis, untuk memperkenalkan cara menulis huruf besar di kelas II 

SD mempergunakan pendekatan spiral maksudnya huruf demi huruf 

diperkenalkan secara berangsur-angsur sampai pada akhirnya semua huruf 

dikuasai oleh para siswa. Kemampuan menulis yang diperoleh siswa di kelas I 

dan kelas II tersebut akan menjadi dasar pembelajaran menulis di kelas-kelas 

berikutnya. 

 

2.2.3 Pembelajaran Menulis Permulaan 

Kemampuan menulis permulaan tidak jauh berbeda dengan kemampuan 

membaca permulaan.Pada tingkat dasar atau permulaan, pembelajaran menulis 

lebih diorientasikan pada kemampuan yang bersifat mekanik.Anak-anak dilatih 

untuk dapat menuliskan (mirip dengan kemampuan melukis atau menggambar) 

lambang-lambang tulis yang jika dirangkaikan dalam sebuah struktur, lambang-

lambang itu menjadi bermakna.Selanjutnya dengan kemampuan dasar ini, secara 

perlahan-lahan anak-anak digiring pada kemampuan menuangkan gagasan, 

pikiran, perasaan, ke dalam bentuk bahasa tulis melalui lambang-lambang tulis 

yang dikuasainya.Inilah kemampuan menulis yang sesungguhnya. 

Untuk kemampuan menulis di kelas satu (kelas rendah), kurikulum 2004 

menetapkan standar kompetensi sebagai berikut : Siswa mampu menulis beberapa 

kalimat yang dibuat sendiri dengan huruf lepas dan huruf sambung, menulis 

kalimat yang didiktekan guru,dan menulis rapi menggunakan huruf sambung. 

Standar kompetensi ini diturunkan menjadi beberapa kompetensi dasar, yaitu : 
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1.      Membiasakan sikap menulis yang benar. 

2.      Menjiplak dan menebalkan. 

3.      Menyalin.  

4.      Menulis permulaan. 

5.      Menulis beberapa kalimat dengan huruf sambung. 

6.      Menulis kalimat yang didiktekan guru. 

7.      Menulis dengan huruf sambung. 

 

2.3 Android 

Android adalah sistem operasi berbasis Linux yang dirancang untuk 

perangkat seluler layar sentuhseperti telepon pintar dan komputer tablet.Android 

awalnya dikembangkan oleh Android, Inc., dengan dukungan finansial 

dari Google, yang kemudian membelinya pada tahun 2005. Sistem operasi ini 

dirilis secara resmi pada tahun 2007, bersamaan dengan didirikannya Open 

Handset Alliance, konsorsium dari perusahaan-perusahaan perangkat keras, 

perangkat lunak, dan telekomunikasi yang bertujuan untuk memajukan standar 

terbuka perangkat seluler.Ponsel Android pertama mulai dijual pada bulan 

Oktober 2008. 

Antarmuka pengguna Android didasarkan pada manipulasi langsung, 

menggunakan masukan sentuh yang serupa dengan tindakan di dunia nyata, 

seperti menggesek, mengetuk, mencubit, dan membalikkan cubitan untuk 

memanipulasi obyek di layar. Android adalah sistem operasi dengan sumber 

terbuka, dan Google merilis kodenya di bawah Lisensi Apache.Kode dengan 
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sumber terbuka dan lisensi perizinan pada Android memungkinkan perangkat 

lunak untuk dimodifikasi secara bebas dan didistribusikan oleh para pembuat 

perangkat, operator nirkabel, dan pengembang aplikasi. Selain itu, Android 

memiliki sejumlah besar komunitas pengembang aplikasi (apps) yang memperluas 

fungsionalitas perangkat, umumnya ditulis dalam versi kustomisasi bahasa 

pemrograman Java. Pada bulan Oktober 2012, ada sekitar 700.000 aplikasi yang 

tersedia untuk Android, dan sekitar 25 juta aplikasi telah diunduh dari Google 

Play, toko aplikasi utama Android.Sebuah survey pada bulan April-Mei 2013 

menemukan bahwa Android adalah platform paling populer bagi para 

pengembang, digunakan oleh 71% pengembang aplikasi seluler. 

Faktor-faktor di atas telah memberikan kontribusi terhadap perkembangan 

Android, menjadikannya sebagai sistem operasi telepon pintar yang paling banyak 

digunakan di dunia, mengalahkan Symbian pada tahun 2010. Android juga 

menjadi pilihan bagi perusahaan teknologi yang menginginkan sistem operasi 

berbiaya rendah, bisa dikustomisasi, dan ringan untuk perangkat berteknologi 

tinggi tanpa harus mengembangkannya dari awal. Akibatnya, meskipun pada 

awalnya sistem operasi ini dirancang khusus untuk telepon pintar dan tablet, 

Android juga dikembangkan menjadi aplikasi tambahan di 

televisi, konsol permainan, kamera digital, dan perangkat elektronik lainnya. Sifat 

Android yang terbuka telah mendorong munculnya sejumlah besar komunitas 

pengembang aplikasi untuk menggunakan kode sumber terbuka sebagai dasar 

proyek pembuatan aplikasi, dengan menambahkan fitur-fitur baru bagi pengguna 
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tingkat lanjut atau mengoperasikan Android pada perangkat yang secara resmi 

dirilis dengan menggunakan sistem operasi lain. 

Pada November 2013, Android menguasai pangsa pasar telepon pintar 

global, yang dipimpin oleh produk-produk Samsung, dengan persentase 64% pada 

bulan Maret 2013. Pada Juli 2013, terdapat 11.868 perangkat Android berbeda 

dengan beragam versi. Keberhasilan sistem operasi ini juga menjadikannya 

sebagai target ligitasi paten "perang telepon pintar" antar perusahaan-perusahaan 

teknologi. Hingga bulan Mei 2013, total 900 juta perangkat Android telah 

diaktifkan di seluruh dunia, dan 48 miliar aplikasi telah dipasang dari Google 

Play.Pada tanggal 3 September 2013, 1 miliar perangkat Android telah diaktifkan. 

 

2.4 Unity  

Unity merupakan salah satu game engine yang banyak digunakan. Unity 

menyediakan fitur pengembangan game dalam berbagai platform, yaitu Unity 

Web, Windows, Mac, Android, iOS, XBox, Playstation 3 dan Wii.Versi gratis 

unity menyediakan fitur pengembangan game berbasis windows, standalone mac, 

dan web. Sedangkan untuk platform lainnya diperlukan lisensi khusus. Unity pro 

juga menyediakan beberapa fitur lebih jika dibandingkan unity free, misalkan 

adalah efek bayangan pada objek dan efek water yang lebih memukau. 

Dalam unity disediakan berbagai pilihan bahasa pemrograman untuk 

mengembangkan game, antara lain JavaScript, C#, dan BooScript. Namun 

meskipun disediakan tiga bahasa pemrograman, kebanyakan developer 
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menggunakan JavaScript dan C# sebagai bahasa yang digunakan untuk 

mengembangkan game mereka. 

Unity Mensuport pembuatan game 2D dan 3D, namun lebih ditekankan 

pada 3D. Pengembangan game lebih ditekankan pada desain dan tampilan visual 

daripada pemrograman. 

 

2.4.1 Penggunaan Software Unity 

• Membuat Project Baru 

Klik File -> New ProjectMaka akan muncul window Unity Project 

Wizard. Pada window ini anda akan diminta memasukkan lokasi dimana project 

anda, dan Package apa saja yang anda butuhkan pada project anda. Jika anda ragu 

untuk memilih Package yang akan diimport, maka lebih baik anda tidak 

mengimport package sama sekali. 

 
Gambar 2.1Membuat Project Baru Unity 
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Setelah anda selesai menentukan lokasi dan memilih Package kemudian 

klik Create. Tunggu bebeapa saat maka project baru akan dibuat.Lihat gambar di 

bawah. 

 
Gambar 2.2Bagian Layout Project Baru Unity 

• Mengganti Platform dan Konfigurasinya 

Setelah project baru dibuat maka langkah selanjutnya adalah mengatur 

platform dari project , apakah untuk Windows, Mac, Android, iOS, dsb. Untuk 

mengatur platform, klik File -> Build Settings. Setelah anda klik maka Window 

Build Settings akan muncul. Pada window itu anda akan diberi pilihan platfrom 

yang dapat anda gunakan. Untuk Unity versi free, platform yang tersedia hanya 

Web Player dan PC/Mac Standalone. Setelah anda menentukan platform anda, 

klik Switch Platform. 

Anda juga dapat melakukan konfigurasi dari Platform dengan mengklik 

Player Settings. Konfigurasi akan ditampilkan pada Window Inspector. 
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Gambar 2.3Mengganti Platform dan Konfigurasi 

 

• Setting Kualitas Grafik 

Langkah selanjutnya adalah konfigurasi grafik. Lakukan dengan bijak 

konfigurasi ini. semakin baik kualitas grafik maka akan semakin memperburuk 

performa. Untuk mensetting kualitas grafik anda dapat masuk Edit -> Project 

Setting -> Quality. Lihatlah pada window Inspector untuk mengkonfigurasi. 

Disini anda dapat melakukan setting project dari berbagai platform. 
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Gambar 2.4Setting Kualitas Grafik 

 

• Tentang Window 

Seperti kebanyakan software lainnya, Unity terdiri dari window-window, 

dimana setiap window memiliki fungsi masing-masing. Anda dapat menampilkan, 

menyembunyikan, merubah ukuran, dan mengatur tata letak dari window. 

Window dapat anda munculkan dengan klik Window -> Pilih Window yang akan 

dimunculkan. 

Berikut adalah window yang paling penting dan paling sering digunakan 

dalam menggunakan Unity : 

o Window Scene 

Merupakan window untuk mengatur tata letak dari suatu object dalam game. 

Misal anda dapat mengatur letak kamera, terrain, atau object lain dalam window 
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ini. Anda dapat memasukkan Object dengan melakukan drag drop dari window 

Project ke dalam Window ini. 

o Window Game 

Merupakan window simulasi game ketika game dijalankan. Window ini 

banyak berfungsi pada proses debugging ketika anda menjalankan game anda. 

o Window Inspector 

 window Properties pada kebanyakan aplikasi seperti VB dsb. Pada window ini 

disediakan berbagai pengaturan. Isi dari window ini dapat berubah ubah ketika 

anda mengklik object yang berbeda. 

o Window Hierarchi 

Berhubungan dengan window Scene. Apa yang ada dalam window Scene akan 

ditampilkan secara list di window ini. 

o Window Project 

Pada window ini terdapat hirarki dari folder-folder asset yang anda miliki. 

Asset dapat anda gunakan dengan melakukan drag drop ke window scene 

o Window Animation 

Pada window ini anda dapat membuat animasi sederhana untuk game anda, 

misal animasi rotasi untuk membuka pintu, animasi translasi untuk menggerakkan 

jendela, dsb. untuk animasi yang rumit tidak dapat anda lakukan disini, akan 

tetapi pada software modelling anda, misal blender, 3dsmax, dsb. 
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• Scene 

Scene dapat dianalogikan sebagai level permainan, meskipun tidak 

selamanya scene adalah level permainan. Misal, level1 anda letakkan pada scene1, 

level2 pada scene2, dst. Namun scene tidak selamanya berupa level, bisa jadi 

lebih dari satu level anda letakkan dalam satu scene. Game menu biasanya juga 

diletakkan pada satu scene tersendiri.  Suatu scene dapat berisi beberapa  

GameObject. Antara satu scene dengan scene lainnya bisa memiliki GameObject 

yang berbeda. Scene diatur pada window scene dan hierarchy. Scene dapat anda 

simpan dengan klik file -> save scene. 

 

 
Gambar 2.5Scene Unity 

• Asset dan Package 

Suatu asset dapat terdiri dari beberapa package. Asset dan package adalah 

sekumpulan object yang disimpan. Object dapat berupa GameObject, terrain, dsb. 

Dengan adanya asset/package anda tidak perlu susah-susah membuat object lagi 
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jika anda telah membuatnya sebelumnya. Anda dapat mengimport nya dari project 

lama anda. 

Sebuah ilustrasi, pada project lama anda telah membuat object tank 

lengkap dengan AI, control, missile, dan ledakan. Kemudian anda akan membuat 

project baru yang memerlukan object tank yang pernah anda buat sebelumnya. 

Maka anda tidak perlu repot-repot membuatnya dari awal. Cukup buka project 

lama anda, lihat window project, carilah object mana yang akan anda gunakan. 

Kemudian klik kanan -> Export Package. Package akan disimpan dalam format 

.unitypackage. Kemudian anda dapat membuka project baru dan mengimport 

packagenya dengan klik Assets -> Import Packake -> Custom Package. Anda juga 

dapat berbelanja berbagai macam package yang anda butuhkan di unity assets 

store. Bukalah Window -> Asset Store. 

 

• Menambahkan Object ke dalam scene 

 Untuk menambah object anda dapat mengklik GameObject -> Pilih yang 

anda inginkan. Anda dapat juga menambahkan Object dalam scene dari asset yang 

anda miliki. Anda juga dapat membuat berbagai object 3D anda sendiri beserta 

animasinya dengan software lain, misal blender, 3dsmax, dsb. Untuk 

mengimportnya dapat anda lakukan drag drop dari file 3D ke dalam window 

Project. Unity mensuport berbagai format 3D antara lain .fbx, .blend, .max, .3ds, 

dsb. Keseluruhan object tersebut secara otomatis akan dijadikan object .fbx oleh 

unity dan akan diletakkan pada window project. 
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Gambar 2.6Menambah Object Kedalam Scene 

 

• Component 

 Jika anda telah mengimport object dan meletakkan pada scene, apa yang 

dapat dilakukan object tersebut selain diam? Disinilah component berperan, 

dengan menggunakan component anda dapat menambahkan perilaku dari object, 

misalkan gravity, collider, cloth, controller, dsb. Component sebenarnya adalah 

sekumpulan script. Anda juga dapat membuat script anda sendiri dengan 

menggunakan C#, javascript, atau booscript. Untuk menambahkan component 

cukup klik object anda dalam scene -> klik component -> pilih yang akan anda 

gunakan. Jika anda memiliki script anda sendiri, anda dapat melakukan drag drop 

script anda dari window project ke object anda di window scene atau hierarchy. 
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• Build Project 

Inilah yang ditunggu tunggu setelah anda membuat project anda. Ini 

merupakan langkah terakhirsetelah program selasai di buat. Untuk melakukan 

build dapat anda klik File -> Build and Run. 

 

2.5 Adobe PhotoShop 

Photoshop adalah suatu program editing gambar yang dipergunakan untuk 

membuat, mengolah dan menghasilkan suatu gambar (image) digital dengan cara 

tehnik dan meng-efek, sehingga gambar terlihat lain dari aslinya dan berkualitas 

tinggi. Dengan Adobe Photoshop kita dapat mendesain berbagai macam bentuk 

ilustrasi secara tepat seperti : koran, tabloid, cover buku, brosur dan lain-lain.  

Adobe Photoshop, perangkat lunak editor citra buatan Adobe Systems 

yang dikhususkan untuk pengeditan foto/gambar dan pembuatan efek. Perangkat 

lunak ini banyak digunakan oleh fotografer digital dan perusahaan iklan sehingga 

dianggap sebagai pemimpin pasar (market leader) untuk perangkat lunak 

pengolah gambar/foto, dan, bersama Adobe Acrobat, dianggap sebagai produk 

terbaik yang pernah diproduksi oleh Adobe Systems. Versi kedelapan aplikasi ini 

disebut dengan nama Photoshop CS (Creative Suite), versi sembilan disebut 

Adobe Photoshop CS2, versi sepuluh disebut Adobe Photoshop CS3 , versi 

kesebelas adalah Adobe Photoshop CS4 , versi keduabelas adalah Adobe 

Photoshop CS5 , versi (ketigabelas) adalah Adobe Photoshop CS6, dan Versi 

yang terakhir adalah versi(keempatbelas) Adobe Photoshop CS7. 
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2.5.1 Komponen Dari Adobe Photoshop 

o Title Bar  

Menampilkan nama file yang sedang aktif dan bisa di gunakan untuk 

memindahkan posisi jendela photoshop pada dekstop. 

o Menu Bar 

Berisi deretan menu yang meliputi : File, Edit, Image, Layer, Select, 

Filter, View, Windows, Help. 

o Ruler 

Atau yang disebut juga penggaris yang berguna untuk menentukan 

posisi serta ukuran suatu objek. 

o Status Bar  

Bagian ini menampilkan berbagai informasi tentang objek dan perkakas 

yang sedang di pilih. 

o Drawing Windows  

Daerah yang digunakan sebagai lembar kerja untuk berkreasi dengan 

foto atau gambar. 

o Toolbox  

Komponen yang digunakan untuk memberikan akses perintah ke 

photoshop. 

o Pallete  

Komponen ini digunakan untuk memilih dan mengatur berbagai 

parameter. 
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o SizingButton  

Tombol ukuran yang berada pada kanan atas jendela Potoshop. 

 

2.5.2 Tools dari PhotoShop 

2.5.2.1 Crop & Slice Tool  

o Crop Tool – Shortcut (C), digunakan untuk memotong gambar, foto 

ataupun canvas (kertas kerja). Pemotongan dengan alat ini dilakukan 

secara permanen mengubah bentuk dimensi lebar dan tinggi foto. 

Pemotongan dilakukan dengan menentukan area potong berbentuk 

kotak dari sebuah foto. 

o Slice Tool – Shortcut (C), digunakan untuk kebutuhan website dengan 

cara memotong hasil desain yang telah dibuat di Photoshop menjadi 

potongan yang lebih kecil. 

o Slice Select Tool – Shortcut (C), digunakan untuk memilih potongan 

pada sebuah desain yang telah dipotong sebelumnya dengan 

menggunakan slice tool. 

 

2.5.2.2 Annotation, Measuring & Navigation Tool 

• Eyedropper Tool - Shortcut (I), digunakan untuk mengambil sample 

warna dari sebuah gambar ataupun foto, sample warna diambil dengan 

cara mengklik warna target yang kemudian secara otomatis akan 

mengubah warna depan (foreground color) pada toolbox. 
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• Ruler Tool – Shortcut (I), digunakan untuk mengukur dimensi lebar 

dan tinggi.  alat ini biasanya digunakan untuk kebutuhan website seperti 

mengukur dan memperkirakan interface tinggi & lebar tombol, header 

ataupun area website lainnya. Satuan yang digunakan biasanya pixels. 

• Note tool - Shortcut (I), digunakan untuk memberikan catatan pada 

hasil desain yang telah di buat. Catatan ini berguna sebagai pengingat 

dalam proses pembuatan desain ataupun dapat berguna sebagai media 

untuk penyampaian sebuah pesan ketika bekerja secara team. 

• Hand Tool – Shortcut (H), digunakan untuk menggeser/memindah 

bidang pandang foto atau gambar di dalam window view area atau 

dalam kondisi gambar sedang di perbesar (zoom in). Cukup tekan dan 

tahan tombol spasi untuk meminjam alat ini. 

• Zoom Tool - Shortcut (Z), digunakan untuk memperbesar ataupun 

memperkecil tampilan foto atau gambar. Pengaturan zoom in atau zoom 

out dapat dilakukan melalui option bar. 

 

2.5.2.3 Selection Tool 

o Move Tool – Shortcut (V), alat ini digunakan untuk memindahkan 

posisi layer dalam satu foto ataupun memindahkan sebuah foto atau 

layer dalam sebuah foto ke foto yang lain / foto yang berbeda. 

o Rectangular Marquee Tool – Shortcut (M), alat ini digunakan untuk 

menyeleksi objek yang berbentuk kotak. Klik kanan diatas alat ini maka 

akan muncul alat lain dari kelompok marquee tool seperti Eliptical 
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Marquee Tool, Single Row Marquee tool dan Single Column Marquee 

Tool. 

o Eliptical Marquee Tool – Shortcut (M), alat ini digunakan untuk 

menyeleksi objek yang berbentuk lingkaran seperti menyeleksi 

lingkaran mata, ban mobil dan objek lain. Alat ini masih satu kelompok 

dengan Rectangular Marquee Tool. 

o Lasso Tool – Shortcut (L), digunakan untuk menyeleksi objek dengan 

bentuk bebas, alat ini akan membentuk seleksi sesuai dengan gerakan 

mouse, penggunaan alat ini sangat bergantung dengan gerakan mouse 

sehingga cukup sulit mengendalikan dan mencapai hasil yang 

maksimal. 

o Polygonal Lasso Tool – Shortcut (L), digunakan untuk menyeleksi 

objek dengan bentuk bebas bersudut, alat ini membentuk seleksi 

melalui titik-titik point yang dibuat dengan menggunakan klik kiri 

mouse. Alat ini juga dapat digunakan untuk memotong dan mengubah 

background foto. 

o Magnetic Lasso Tool – Shortcut (L), digunakan untuk menyeleksi 

objek dengan bentuk bebas, cara kerja alat ini adalah menempel pada 

tepi objek yang akan dipotong ketika mouse bergerak mengelilingi 

tepian objek, selama proses seleksi alat ini membentuk titik-titik 

penghubung seleksi. 

o Magic Wand Tool – Shortcut (W), digunakan untuk  menyeleksi satu 

jenis warna (warna solid) pada foto. Alat ini dapat menyeleksi dengan 
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pengaturan nilai tolerance atau nilai cakupan warna, semakin besar nilai 

tersebut maka semakin luas cakupan warna yang di seleksi. 

 

2.5.2.4 Retouching Tool  

• Spot Healing Brush – Shortcut (J), digunakan untuk menghapus noda 

pada sebuah foto ataupun gambar, alat ini juga biasanya digunakan 

untuk menghilangkan noda di wajah ataupun menghilangkan jerawat 

diwajah. 

• Patch Tool – Shortcut (J), digunakan untuk memperbaiki foto dengan 

cara memanfaatkan pola yang terdapat pada foto tersebut. Perbaikan 

dilakukan dengan menyeleksi kerusakan area kemudian menarik seleksi 

tersebut diatas pola target untuk menutupi area kerusakan. 

• Red Eye Tool – Shortcut (J), digunakan untuk menghilangkan efek 

mata merah yang timbul pada foto akibat pengambilan foto dalam 

kondisi gelap menyebabkan flash kamera memantulkan warna merah 

pembuluh darah dibalik mata. 

• Clone Stamp Tool – Shortcut (S), digunakan untuk mengambil sample 

dari sebuah area gambar kemudian mengkloning / menerapkan sample 

tersebut untuk dilukiskan diatas area foto lain berdasarkan sample foto 

yang diambil. 

• Pattern Stamp Tool – Shortcut (S), digunakan untuk melukis image 

dengan menggunakan pola tertentu sesuai dengan pola yang dipilih 

pada option bar. 
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• Eraser Tool – Shortcut (E), digunakan untuk menghapus foto atau 

gambar dalam sebuah layer raster. 

• Background Eraser Tool – Shortcut (E), digunakan untuk menghapus 

foto atau gambar sehingga menghasilkan layer transparant pada bagian 

foto atau pada area yang dihapus. 

• Magic Eraser Tool – Shortcut (E), digunakan untuk menghapus area 

tertentu dari sebuah foto atau gambar yang memiliki warna yang serupa 

(satu warna solid) menjadi transparan dengan satu kali klik pada area 

warna tersebut. Bisa dimanfaatkan untukmenghapus background satu 

warna. 

• Blur Tool  – digunakan untuk menghaluskan/mengaburkan area tertentu 

dari sebuah foto atau gambar. Dengan mengaburkan gambar akan 

memberikan kesan halus, blur juga dapat menyamarkan pixels gambar. 

• Sharpen Tool – digunakan untuk menajamkan area tertentu dari sebuah 

foto atau gambar. 

• Smudge Tool – digunakan untuk menggosok/mencoreng area tertentu 

dari sebuah foto atau gambar seolah-olah di pengaruhi oleh sapuan jari 

telunjuk diatas sebuah lukisan. 

• Dodge Tool – Shortcut (O), digunakan untuk menerangkan warna di 

area tertentu pada gambar atau foto dengan memberikan highlights pada 

area tertentu hingga area tersebut tampak lebih cerah / terang. 
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• Burn Tool  - Shortcut (O), digunakan untuk menggelapkan warna di 

area tertentu pada gambar atau foto dengan memberikan shadow / 

bayangan pada area tertentu hingga tampak lebih gelap. 

• Sponge Tool – Shortcut (O), digunakan untuk mengubah saturation di 

area tertentu pada area gambar atau foto. 

 

2.5.2.5 Painting Tool 

• Brush Tool – Shortcut (B), digunakan untuk melukis foto atau gambar 

dengan goresan kuas berdasarkan warna depan (foreground color) yang 

telah dipilih. 

• History Brush Tool – Shortcut (Y), digunakan untuk melukis image 

menggunakan snapshot atau state history dari Image. 

• Art History Brush Tool  - Shortcut (Y), digunakan untuk melukis 

image menggunakan snapshot atau state history dari image, dengan 

model artistik tertentu. 

• Pencil Tool – Shortcut (B), digunakan untuk melukis dengan efek 

goresan pensil. 

• Gradient Tool – Shortcut (G), digunakan untuk mengecat area yang 

dipilih (selected area) dengan perpaduan dua warna atau lebih. Gradient 

ini juga memiliki beberapa pengaturan dan tipe untuk menghasilkan 

efek perpaduan warna yang sesuai dengan keinginan. 
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• Paint Bucket Tool – Shortcut (G), digunakan untuk mengecat atau 

mewarnai area tertentu atau layer tertentu berdasarkan warna depan 

(foreground color) yang telah dipilih. 

 

2.5.2.6 Drawing and Type Tool 

• Path Selection Tool - Shortcut (A), digunakan untuk menyeleksi path 

yang telah dibuat dengan menggunakan pen tool. 

• Horizontal Type Tool – Shortcut (T), digunakan untuk membuat teks 

secara horizontal. Selain alat ini ada juga Vertical Type Tool untuk 

membuat teks secara vertical dan type mask untuk membuat teks dalam 

bentuk seleksi. 

• Pen Tool – Shortcut (P), digunakan untuk menggambar path sudut 

ataupun lengkung. Alat ini biasa juga digunakan untuk menyeleksi 

objek. Selain alat ini ada kumpulan alat lain untuk menambah titik 

point, mengurangi dan memodifikasi path yang telah dibuat. 

 

2.6 Unified Modeling Language 

UML dipergunakan untuk menggambarkan rancangan sebuah sistem yang 

dibangun. Berikut Definisi Unified Modeling Language (UML) menurut para 

ahli : 

a. Menurut (Henderi, 2008) “Unified Modeling Language (UML) adalah 

bahasa yang telah menjadi standard untuk visualisasi, menetapkan, 
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membangun dan mendokumentasikan artifak suatu sistem perangkat 

lunak”. 

b. UML(Unified Modeling Language) adalah sebuah bahsa untuk 

menspesifikasikan, memvisualisasikan, serta mengkonsturksi 

bangunan dasar dari sistem perangkat lunak termasuk didalamnya 

dengan melibatkan pemodelan aturan- aturan bisnis.”  

 

2.6.1 Use Case Diagram 

Use Case Diagramadalah diagram yang menggambarkan pola hubungan 

antara pengguna dengan sistem.  

Berikut  definisi Use Case menurut para ahli : 

a. Use Case menurut Martin Fowler (2005 : 141) adalah teknik untuk 

merekam persyaratan fungsional sebuah sistem. Use Case 

mendeskripsikan interaksi tipikal antara para pengguna sistem 

dengan sistem itu sendiri, dengan memberi sebuah narasi tentang 

bagaimana sistem tersebut digunakan. Use Case Diagram 

menampilkan hubungan antara aktor dan use case. 

b. MenurutBooch(2005),suatuusecasediagrammenampilkansekumpula

nusecase danaktor(pelaku)danhubungandiantarausecasedan actor 

tersebut.Usecasediagram digunakanuntuk 

penggambaranusecasestatic darisuatusistem.Usecasediagram penting 

dalam mengatur dan memodelkan kelakuan dari suatu sistem. 
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Sehingga dapat ditarik kesimpulan 

bahwaUsecasemenjelaskanapayangdilakukansistem(atausubsistem)tetapitidakmen

spesifikasikan cara kerjanya. Flow of event digunakan untuk 

menspesifikasikankelakuandariusecase.Flowofeventmenjelaskanusecasedalam 

bentuktulisandengan sejelas- jelasnya, diantaranya bagaimana, kapanuse case 

dimulai dan berakhir, ketikause case berinteraksi dengan aktor, obyek apa 

yangdigunakan, alur dasar dan alur alternatif. 

Tabel 2.1 Simbol Use Case 
NO GAMBAR  NAMA KETERANGAN 

1  Actor 

Perandaripenggunamainkanketikaberinteraksidenganuse case. 

2  Dependency 

Hubungandimanaperubahan yang 

terjadipadasuatuelemenmendiriakanmempengaruhielemen yang 

bergantungpadanya. 

3  Generalization 

Hubungandimanaobjekanak (descendent) berbagiprilakustruktur 

data dariobjek yang ada di atasnyaobjekinduk (ancestor) 

4  Include 
Menspesifikanbahwausecasesumbersecaraeksplisit. 

5  Extend 

Menspesifikanbahwausecasememperluasprilakudarisumberdarititik 

yang diberikan. 

6  Association 
Menghubungkandariobjeksatukeobeklainnya. 
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2.6.2 Sequence Diagram 

Merupakan diagram yang secara grafis menggambarkan bagaimana objek 

berinteraksi dengan satu sama lain melalui pesan pada sekuensi sebuah use 

case atau operasi. 

a. MenurutBooch(2005) : 

“sequencediagramadalahsuatudiagraminteraksiyang menekankan  pada 

pengaturan waktu dari pesan - pesan diagram ini menampilkan 

sekumpulan peran dan pesan-pesan yang dikirim dan diterima oleh 

instansi yang memegang peranan tersebut.”  

 

b. Sequence diagram menurut Munawar (2005 : 187) adalah grafik dua 

dimensi dimana objek ditunjukkan dalam dimensi horizontal, 

sedangkan lifelineditunjukkan dalam dimensi vertikal.  

 

Sequence diagram menangkap objek dan class yang terlibat dalam 

skenario dan urut-urutan pesan yang ditukar antara objek diperlukan untuk 

melaksanakan fungsionalitas skenario. Sequence diagram berasosiasi dengan 

usecase selama proses pengembangan. Dalam Unified Model Language (UML), 

objek dalam sequencediagram digambar dengan segiempat yang berisi nama 

objek yang diberi garis bawah. Objek dapat diberi nama dengan tiga cara : (nama 

objek), (nama objek dan class) atau (hanya nama class (anonymous object). 

Berikut notasi sequence diagram seperti terlihat pada gambar dibawah ini : 

 



 

 

Tabel 2.2 Simbol Sequence Diagram
NO GAMBAR

1 

 

2 

3 

 

 

2.6.3 Class Diagram

Class diagram menurut Munawar (2005 : 28) merupakan himpunan dari 

objek-objek yang sejenis. Sebuah objek memiliki keadaan sesaat (state) dan 

perilaku (behavior). State sebuah objek adalah kondisi objek 

dinyatakan dalam attribute/properties. Sedangkan perilaku suatu objek 

mendefinisikan bagaimana sebuah objek bertindak/beraksi dan memberikan reaksi

Class Diagram adalah diagram yang menunjukan class

sebuah sistem dan hubungannya secara logika. Class diagram menggambarkan 

struktur statis dari sebuah sistem. Karena itu class diagram merupakan tulang 

punggung atau kekuatan dasar dari 

termasuk UML (Henderi, 2008).

Tabel 2.2 Simbol Sequence Diagram 
GAMBAR  NAMA KETERANGAN

LifeLine 

Objek entity, antarmuka yang saling 

berinteraksi. 

 

 

 
Message 

Spesifikasi dari komunikasi antar objek 

yang memuat informasi

tentang aktifitas yang terjadi

 

Message 

Spesifikasi dari komunikasi antar objek 

yang memuat informasi

tentang aktifitas yang terjadi

Class Diagram 

Class diagram menurut Munawar (2005 : 28) merupakan himpunan dari 

objek yang sejenis. Sebuah objek memiliki keadaan sesaat (state) dan 

perilaku (behavior). State sebuah objek adalah kondisi objek 

dinyatakan dalam attribute/properties. Sedangkan perilaku suatu objek 

mendefinisikan bagaimana sebuah objek bertindak/beraksi dan memberikan reaksi

Class Diagram adalah diagram yang menunjukan class-class yang ada dari 

sebuah sistem dan hubungannya secara logika. Class diagram menggambarkan 

struktur statis dari sebuah sistem. Karena itu class diagram merupakan tulang 

punggung atau kekuatan dasar dari hampir setiap metode berorientasi objek 

termasuk UML (Henderi, 2008). 
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KETERANGAN  

, antarmuka yang saling 

Spesifikasi dari komunikasi antar objek 

yang memuat informasi-informasi 

tentang aktifitas yang terjadi 

Spesifikasi dari komunikasi antar objek 

yang memuat informasi-informasi 

tentang aktifitas yang terjadi 

Class diagram menurut Munawar (2005 : 28) merupakan himpunan dari 

objek yang sejenis. Sebuah objek memiliki keadaan sesaat (state) dan 

perilaku (behavior). State sebuah objek adalah kondisi objek tersebut yang 

dinyatakan dalam attribute/properties. Sedangkan perilaku suatu objek 

mendefinisikan bagaimana sebuah objek bertindak/beraksi dan memberikan reaksi 

class yang ada dari 

sebuah sistem dan hubungannya secara logika. Class diagram menggambarkan 

struktur statis dari sebuah sistem. Karena itu class diagram merupakan tulang 

hampir setiap metode berorientasi objek 
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2.6.4 Activity Diagram 

Activity Diagram digunakan untuk menggambarkan rangkaian aliran 

aktivitas baik proses bisnis maupun use case. Activity diagram dapat juga 

digunakan untuk memodelkan actionyang akan dilakukan saat sebuah operasi 

dieksekusi, dan memodelkan hasil dari actiontersebut. 

 

Berikut definisi activity diagram menurut para hali : 

a. Activity diagram menurut Martin Fowler (2005 : 163) adalah teknik 

untuk menggambarkan logika prosedural, proses bisnis, dan jalur 

kerja. 

b. Menurut Satzinger et al. (2010, p.141) Activity diagram merupakan 

sebuah tipe dari diagram workflow yang menggambarkan tentang 

aktivitas dari pengguna ketika melakukan setiap kegiatan dan aliran 

sekuensial. 

Dapat disimpulkan bahwa Activity diagram merupakan teknik yang 

menggambarkan aliran kerja atau proses. 

 

 

 

 

Tabel 2.3 Activity Diagram 
NO GAMBAR NAMA KETERANGAN 
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1 

 

State 

Nilai atribut dan nilai link pada suatu 

waktu tertentu, yang dimiliki oleh suatu 

objek. 

2 
 

Initial Pseudo 

State 
Bagaimana objek dibentuk atau diawali 

3 
 

Final State 
Bagaimana objek dibentuk dan 

dihancurkan 

4 
 

Transition 

Sebuah kejadian yang memicu sebuah state 

objek dengan cara memperbaharui satu 

atau lebih nilai atributnya 

5 
 

Association 
Apa yang menghubungkan antara objek 

satu dengan objek lainnya. 

6 

 

Node 

Elemen fisik yang eksis saat aplikasi 

dijalankan dan mencerminkan suatu 

sumber daya komputasi. 

 


